
 

 

 
FastDraw​ Volleyball 

 

 
 

User​ Guide 
 
 
 
 
 
 
 
 
 
 
 

 



 

Contents 
 
Getting Started ​ - The Position Editor ..……………………………………………...……………………………………..3 
Getting Started ​ - Creating Building Blocks and Plays ………………………………………………………………..5 

The New Play Menu ……...…….……………………..……………………………………………………………………………..5 
Building Blocks   ..…………...…………………………………..…...………………………………………………………………….5 
 

The Draw Tab…………………………………………………………………………………………………………………………………….7 
Using Play Filters ………………………………………………………………………………………………………………….9 
Diagramming a Play ………………………………………………………………………………………………………………..10 
FastBuild …………………………………………………………………………………………………………………………….14 
Frame Descriptions ………………………………………………………………………………………………………………...14 
Coaching Points ………………………………………………………………………………………………………………...15 

 
The Right-Click Menu ………………………...………………………………………………………………………………….17 

Right-Click Options …..…..………………………………………………………………………………………………………..18 
 

Adding Building Blocks to Plays ………………………………………………………………………………………………..18 
 
Getting Started ​ - Creating a Playbook and Printing a Play ………………………………………………….20 

FastPrint …………………………………………………………………………………………………………………………...20 
The Preview Tab ……..………………….………………………………………............................................................21 

 
Playbook Settings …………………………………………………………………………………………………………...22 

Saving Print Settings ………………………………………………………………………………………………………………..24 
Printing Coaching Points …………………………………………………………………………………………………….25 

 
Advanced Playbook Settings ………………………………………………………………………………………………..26 
 
Getting Started ​ - The Playbook Tab …………………………………………………………………………………….28 

Playbook Library …………………………..…………………………………………………………………………………...28 
Editing Playbooks ………………………………………………………………………………………………………………..29 
Chapters and Sections …………………………………………………………………………………………………….29 
Deleting Plays ……………………………………………………………………………………………………30 
Adding Plays to a New Playbook ………………………………………………………………………………………...31 
Deleting Playbooks ………………………………………………………………………………………………………………..32 
Creating a New Playbook Folder ………………………………………………………………………………………..33 

 
Getting Started ​ - Saving Plays Using the Sync Button ………………….………………………………………….34 
 

FastDraw Volleyball User Guide    ​  1 



Getting Started ​ - FastTrade ………………………………………………………………………………………………..36 
Locating FastTrade Imports ………………………………………………………………………………………..38 

 
Advanced ​ FastDraw Options ……………………………………………………………………………………………….40 

Changing the Court Background ………………………………………………………………………………………..40 
FastColor …………………………………………………………………………………………………………………………...40 
Editing Plays …………………………………………………………………………………………………………………………….41 
Printing Blank Diagrams …………………………………………………………………………………………………....43 
Adding a Team Logo to Playbooks …………………………………………….......................................................44 
Playbook, Chapter, and Section Settings …………………………………………………………………………….45 
Frame Layout …………………………………………………………………………………………………………………………...45 
Include Table of Contents ………………………………………….………………………………………………………...46 

 
Exporting from FastDraw ………………………………………………………………………………………………..47 

Saving Playbooks as a PDF File ………………………………………………………………………………………...47 
Copying an Image to a Word Document or PowerPoint ……………………………………………………..47 
Saving Plays as image Files ………………………………………………………………………………………..48 
 

Additional ​ FastDraw Resources ………………………………………...…………………………………………………….50 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FastDraw Volleyball User Guide    ​  2 



Getting Started ​ - The Position Editor 
 
Before you get started with creating plays and drills in the FastDraw software, you will want to take a few 
moments to customize a few of your default settings, which will go a long way towards saving you time in 
the future. The first setting that you will want to customize is your default positions. 
 
You can access the Positions Editor by clicking the Edit menu from the top menu bar, and then selecting 
Positions Editor. The Positions Editor menu will allow you to edit the positions that will be available for you 
to select from the Positions palette to add to your diagram. 
 

 
 

 
In the Position Editor menu, by default you will see 8 “Role Positions” activated with a check mark. These 
include positions such as Setter and Outside Hitter 1. You will also see 6 “Court Positions” checked and 
activated, such as Left Front and Middle Front. Lastly, you will see 4 extra “Volleyball Role” positions and 6 
extra “Volleyball Court” positions available, but deactivated by default. 
 
Any Role Positions that you have activated with appear in the Role Positions palette in the Draw tab, and 
any Court Positions that you have activated with likewise appear in the Court Positions palette, making 
them available to add to your diagrams. You can modify the Position name or Text of any of the default 
positions or extra positions, and you can activate or deactivate as many positions as your would like. 
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Each field in the Position Editor menu can be edited to your specifications: 
 
Position ​ - This field is a reference to the player’s position, but will not be included in any diagrams. 
Text ​ - The value entered into this field is exactly what will appear in your diagram, and for the cleanest 
looking diagrams, should be no longer than a 3 letter or digit abbreviation. 
Shape ​ - The selected shape will control how the selected player looks in your diagrams. They can be 
shown as circles, squares, or as plain text with no surrounding shape. 
Foreground and Background Color ​ - The foreground color controls the text color for the player, and the 
background color will change the color filling the circle. 
Preview ​ - This field shows a preview of how the player will look in diagrams with the currently selected 
settings. 
 
*Note: If you choose to edit any of these default values after you have already created plays or drills in 
FastDraw, your changes will be applied to all of your existing diagrams.* 
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Getting Started ​ - Creating Building Blocks and Plays 
 
The New Play Menu ​ - After you have set your default Positions, but before you begin creating new plays 
and drills, you will want to spend some time creating your Building Blocks, which will become the 
foundation to begin many of your plays and drills. ​Building Blocks are a time saving tool, that allows you to 
create formations or commonly run plays and use them as templates when creating more plays. This 
means you don’t have to keep re-drawing similar actions each time you want to begin a play with a similar 
formation.  
 
Building Blocks ​ - To create a new Building Block, click the New Play icon to start a new play. 
 

 
 
It is important to note that while the button is called “New Play” it can refer to any Play, Drill, or diagram of 
any kind. So throughout this Guide, understand that the term “Play” is synonymous with drills and 
diagrams. 
 
After clicking New Play, the new play menu window will appear and you will have the option to create a 
Play or a Building Block, which you can select using the drop down menu in the top right corner next to 
“Type:”. Select Building Block to get started. 
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The Season, Team, and Series labels can be selected for each new Building Block or Play, and you can add 
new Teams or Series using the “Add…” button. Adding each of these labels will improve your ability to 
organize your library and more easily find your plays as your library grows. 
 

 
 

 
In addition to adding labels to your play, you can also adjust the court appearance from the New 
Play menu. When creating a Building Block or Play, be sure to adjust the “Service Zone” and “Side 
Zones” option to match your preferences. When you enable or disable each option, this will in turn 
affect which lines are included in the diagram. 
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*As a best practice, make sure to disable the Service Zone and Side Zones options if you do not require 
them in your diagram. When enabled, these areas will still be included even if no players are placed 
there, and your diagram will be reduced in size to accommodate the added zones.* 
  
 
The Draw Tab 
 
After making your selections, press the OK button and you will be taken to the Draw tab. Draw is 
one of three viewing modes available in FastDraw, with the other two being Playbook and Preview. 
You can switch between each mode using the Tabs on the top left of the page. 
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The Draw window is divided into two sections: the Play Library on the left, and the Play Editor 
window on the right. By placing your mouse over the dividing line between each window, you can 
click and drag the divider left or right to change the percentage of the page that each window 
occupies. 
 

 
 

The Play Library window features two tabs along the left side, which allows you to view your Plays 
and your Building Blocks separately. Click the tab of the desired library that you wish to view to 
switch back and forth between each view. 
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Using Play Filters ​ - In the New Play menu, you selected Season, Team, and Series labels to add to 
your Building Block or Play. In the Play Library window, underneath each column header for Season, 
Team, and Series, there is a drop down menu that can be used to filter your play library and view 
only Building Blocks or Plays that meet your set criteria. To view every play that is currently in your 
play library, the Season, Team, and Series filters will all need to be set to <All>. 
 

 
 
Using the drop down menus, you can isolate Building Blocks or Plays by Season, Team, or Series, or 
a combination of all three. Any plays that do not match your set criteria will be hidden. 
 

 
 

*Note: When you create a new Building Block or Play, your Play Filters are automatically set to match the 
Season, Team, and Series of the play that you just created. If you wish to return back to your full Play 
Library, you must reset each filter back to <All>. Be sure to also check that you are on the correct tab 
(Building Blocks or Play) when looking for your plays.* 
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Diagramming a Play ​ - When you create a new Building Block or Play, it will be loaded into the Play 
Editor window. The Play Editor window is where you diagram your plays. The first step is adding 
players. 

 
Players can be added by dragging each one from the Positions palette to their desired location on 
the court. 

 
 
Remember, the players in the Positions palette will match the default values that you set in the 
Positions Editor. If you ever wish to create a custom label for a player, however, you can do so by 
double-clicking on any player on the court. You will then be able to add any text or numerical value 
that you wish. 

 

FastDraw Volleyball User Guide    ​  10 



With your players in place, you can now drag a movement stencil from the Movement palette into 
the diagram. Pick the shape of the action that you would like, and when you drop the stencil into 
your diagram you will be presented with a menu to select a solid line for player movement, and a 
dotted line for ball movement. 
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After placing a stencil, it will appear on the court with a green dot at either endpoint. The green dots 
can be used to move each endpoint into place: 
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When you add a curved line to the court, you will see the green dots on each endpoint, and a yellow 
circle at the midpoint of the curve. The green dots can be moved to change the endpoints of the 
movement, and the yellow circle can be moved to modify the arc of the curve. 
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FastBuild - ​If your Building Block or Play cannot fit into one frame and will be spread across multiple 
frames, the FastBuild feature is a time-saving tool that will prevent you from having to add each 
player back onto the court in the next Frame. By clicking the FastBuild icon, each player in the 
diagram will be added to the next frame, and if a movement line was placed next to the player, 
FastBuild will automatically move the player or ball to its new location in the next frame. 

 
 
Frame Descriptions - ​In addition to diagramming the actions of a play, you can also add notes 
describing the action in each frame using the Frame Descriptions. Frame Descriptions can be 
accessed by double-clicking directly below the Frame. 
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Coaching Points - ​To add more extensive notes to your play that do not belong in the frame 
description use the Coaching Points section. The Coaching Points section is hidden by default, and 
can be revealed by clicking the small black arrow at the bottom of the Play Editor menu once, or 
clicking and dragging the arrow upward. 
 

 
 

 
 

The “Pos” section can be used to add notes by position, or general notes can be added in the 
“Description” section. Additional rows or columns can also be added to this section by right-clicking 
anywhere in the Coaching Points window, and then choosing the appropriate item from the 
right-click menu. 
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When you print your play, your Coaching Points can be added to the bottom of any diagrammed 
plays. 
 

 
 
*Note: When you add Coaching Points to a play, by default they are not included when the play is 
printed. For information on adding the Coaching Points to your printed play, consult the Playbook 
Settings section of the FastDraw User Guide. 
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The Right-Click menu 
 
If you wish to delete any of the elements that you have added to your diagram, you can do this by 
accessing the right-click menu in the Play Editor window. The right-click menu also contains many 
other FastDraw features that will allow you to quickly make changes to your diagram. There are 
three different right-click menus that you can access, based on where you click: 
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Right-Click Options ​ - Within the right-click menu, there are a number of options available to make 
adjustments to the content within the frames. Here are the most commonly used features: 
 
Clear/Delete Frame ​: When you ​right-click in space​  within the frame, the right-click menu will 
contain a “Frame” sub-menu, and within this menu you can clear all players and stencils within the 
frame, or delete the frame entirely. 
 
Copy/Paste Frame ​: When you ​right-click in space​  within the frame, you will have an option to “Copy 
Frame to Clipboard”. After copying the frame, it can be pasted to another frame within the play, 
pasted into a different play, or pasted externally into a Microsoft Word document (or equivalent). 
 
Delete Selected Stencil ​: You can right-click on any Player or Movement line and select Delete 
Selected Stencil to remove it from the diagram. You can also Cut or Copy any selected Player or 
Movement and paste it into a different frame, or within the same frame. 
 
Change Selected Stencil ​: If you add the wrong type of Movement line (dotted line instead of 
straight line, for example), rather than deleting the line and adding it again, you can simply 
right-click on the line that you wish to change, then select Change Selected Stencil to.  
 
*Note: Other more advanced features contained in the right-click menu are covered later in this guide, in 
the “Advanced FastDraw Options” section. 
 
 
Adding Building Blocks to Plays 
 
Once you have diagrammed your most common rotations as Building Blocks, you can start 
diagramming new Plays, where your already diagrammed Building Blocks can be added to save you 
the time of redrawing your rotations each time. 
 
The process for creating a Play is identical to creating Building Blocks, but in the New Play menu you 
will set the Type to Play, rather than Building Block. 
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To add a Building Block to your Play diagram, click the Building Blocks palette, where your Building 
Blocks will appear in a menu, organized by Series name. When you select a Building Block, it will 
automatically be added to the first frame of your new play. 
 

 
 

 
 
*Note: Only the first frame of a Building Block can be added to a new Play, so it’s best to limit any 
Building Blocks that you create to just one frame.* 
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Getting Started ​ - Creating a Playbook and Printing a Play 
 
To print in FastDraw, one or more plays that you wish to print must be added to a playbook. To 
quickly create a playbook and print your plays, use the FastPrint feature. 
 
FastPrint ​ - To use FastPrint, make a check mark next to each play in your library that you would like 
to print, and then click the FastPrint icon near the top of the page. 

 

 
 

In the FastPrint menu, you can choose to add each play that you have checked, or you can add all of 
the plays that are currently shown in your library. If you have checked all of the plays currently 
shown in your library, it will automatically select All Shown Plays. You can then make a name for 
your playbook, or you can leave it at the default name that FastDraw generates based on date and 
time. 
 

 
 
After clicking OK, you will be automatically taken to the Preview tab. 
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The Preview Tab 
 
In the Preview tab, you will see two windows, just like in the Draw tab. In the left window is your 
Playbook Library, and in the right window is the Print Preview. Also like the Draw tab, you can drag 
the divider between the windows to increase or decrease the size of each window. 
 

 
 
The default print settings in the Preview tab are set to display one frame on each page. To flip 
through the pages of your playbook, you can use the forward and backwards arrows in the Print 
Preview window. 
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Playbook Settings  
 
To modify the layout of your playbook, you can open the Playbook Settings menu by clicking the 
Playbook Settings icon at the top of the page. 
 

 
 
At the top of the Playbook Settings menu are tabs for Playbook, Chapter, and Section. When the 
Playbook tab is selected, all changes that you make in the Playbook Settings menu will affect every 
Chapter, Section, and Play of your playbook. 
 

 
 
In the first section of the Playbook Settings Menu, Page Options, you can modify the Title and 
Subtitle sections of each page, along with the information displayed in the header and footer. 
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The next section is Play Options, and this is where you can alter the number of frames that will be 
displayed on each page, allowing you to include more than one frame per page. 
 

 
 
We recommend you set your Rows per Page to Auto. This way, FastDraw will analyze the content of 
your plays and determine the best number of rows to use to give your playbook the cleanest look. 
This can take into account things like how much text is in the Frame Description, whether you are 
using full court or half court diagrams, etc. 
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Saving Print Settings ​ - If you want to save the settings for the format of your playbook to apply to 
future playbooks, click the Actions button at the top of the menu and select Save Changes. 
 

 
 

Full Page is the name of the default Playbook Settings in FastDraw. If you choose Save Changes to 
Full Page, the current settings will become the default for all future playbooks. If you want to save 
the current settings under a different name, choose Save as New Print Settings and give your 
settings a name. 
 

 
 
After you save your print settings, they will now be available for selection from the Print Settings 
menu. If you want to be sure your new settings are the default for all future playbooks, make sure 
your settings are selected in the Print Settings menu, then click the Actions menu and choose Set as 
Default. 
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Printing Coaching Points ​ - Within the Print Settings menu, you will also see a setting for Coaching 
Points. Selecting this option formats your playbook to display any Coaching Points that you have 
added to a play, and the notes will be added at the bottom of the page underneath the play. If your 
play does not have Coaching Points added, it will appear normally in the playbook without a 
Coaching Points section. 
 

 
 

 
 

*Note: By default, your Coaching Points print setting will have Rows per Page set to Auto. This is the ideal 
setting for Coaching Points. Setting Rows per Page to anything less than 2 can result in problems with 
your diagrams appearing correctly.* 
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Advanced Playbook Settings 
 
As you become more comfortable with the Playbook Settings menu, you may find yourself wanting 
more options to choose from. The Playbook Settings menu is set by default only to display the 
most commonly used settings, but it can be switched to “Advanced” mode to see every formatting 
option available in FastDraw. To make this change, open the File menu from the top menu bar and 
select Program Settings, and then click on the Printing tab. 
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Check the option for “View Print Settings in ‘Advanced’ Mode.” If you frequently make a lot of 
changes to the format of your playbook, also check “Add apply button to allow modifying print 
options before redrawing.” When you return to the Preview tab and open Playbook Settings, you 
will see a much longer list of options to choose from.  
 

  
   
 

Previously whenever you made a change to your settings, such as changing the number of Frames 
per Row, the playbook would redraw immediately. By selecting the option in the Program Settings 
menu to add an Apply button, you can now make all of your changes at once, and then press the 
Apply button to finalize your changes and redraw the playbook. 
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Getting Started ​ - The Playbook Tab 
 
If you want to quickly print plays that you have created in your Draw Library, FastPrint is the 
quickest and easiest way to print. However, if you want to create an organized, comprehensive 
playbook, the Playbook tab is where you can create and edit professional-looking playbooks. 
 
There are 3 separate windows within the Playbook tab. Like the Draw and Preview tabs, the 
windows within the Playbook tab can be resized by clicking and dragging the dividers between each 
window. 

 
 
Playbook Library ​ - In the right window is your Playbook Library. Any Playbooks that you create 
using FastPrint will be listed under the FastPrint folder. Similarly, any playbooks that you receive via 
FastTrade will be located under your FastTrade folder. Playbooks currently in your Playbook Library 
can be deleted, renamed, or copied by right-clicking on the playbook. 
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Editing Playbooks ​ - To edit a playbook, click to highlight the playbook in the Playbook Library 
window, and you will see it open in the (center) Playbook Editor window. Within the Playbook Editor 
window, plays currently in the Playbook can be dragged and dropped to rearrange the order. 
 

 
 
Other Playbook options can be accessed by right-clicking anywhere in the window. 
 

 
 

Chapters and Sections ​ - Chapters and Sections can be used to organize your plays into similar 
categories. To add a new section, right-click within the Playbook Editor window and select New 
Section. 
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Next, you can rename sections by right-clicking directly on the section name. 
 

 
 

After you have created your new Section and renamed it, you can then drag and drop your plays 
into their appropriate Sections. 
 

 
 
Delete Plays ​ - If you want to delete a play, right-click on the play and select Delete Play to remove 
it from your Playbook. This will not delete your play from your Play Library but it will remove it from 
this Playbook. 
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Adding Plays to a New Playbook​ - To create a new blank Playbook, click the New Playbook icon 
from the top of the page. 
 

 
 

In the New Playbook menu, you must name your Playbook, add a name of the first chapter, and 
pick a destination folder for where the Playbook will be housed. 
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Once you have created your playbook, you will see it listed in the Playbook Library, and it will 
automatically open in the Playbook Editor window. 

 

 
 

To add plays, you can drag and drop any play from your Play Library window to your Playbook. 
 

 
 
Deleting Playbooks ​ - Lastly, you can delete any playbooks from your Playbook Library using the 
right-click menu and selecting Delete Playbook. As you receive FastTrades over time, for example, 
your FastTrade folder can become filled with all of the Playbooks that are created when you receive 
a play. These Playbooks can be deleted individually, or they can be cleared all at once by 
right-clicking on the FastTrade folder and selecting Clear Folder. 
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Creating a New Playbook Folder - ​When you create a new playbook, your default options are to 
place the playbook in the FastPrint folder, the FastTrade folder, or within the main Playbooks folder. 
If you would like to further organize your playbooks, you can create new folders under the main 
Playbooks directory and move any previously created playbooks to a new folder. 
 
You can create a new folder by right-clicking on the main Playbooks folder, then selecting New 
Folder. 
 

 
 

After you have created a new folder, you can drag and drop any playbook into the folder, using the 
same method for reordering plays in a playbook. 
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Getting Started ​ - Saving Plays Using the Sync Button 
 

After you are finished creating plays or Playbooks, it is always a good idea to use the Sync button in 
FastDraw, which allows you to save a copy of your play library to the FastModel cloud server. After 
Syncing your library, you can then access it from any computer that you use FastDraw on. 
Additionally, saving your library to our cloud server also protects you from losing your work should 
you suffer a hard drive crash, or if your computer is stolen. 
 
To save your work to the FastModel cloud server, simply click the Sync icon at the top of the page. 
 

 
 
When you click the Sync icon, you will see the Sync to Cloud menu appear. 
 

 
 

Use the Note section to add a note about your Sync, such as what computer you are saving from, or 
what plays or sets have been added to your library. This will help identify the file on our server. 
 
When you click the Sync button, the following processes will happen: 

1. The play library on your computer will be uploaded to the cloud server, and added to your 
existing file on our cloud if one exists already, otherwise a new file will be created for you. 

2. Once the upload is complete, FastDraw will check to see if any plays from the cloud file need 
to be downloaded to your computer, such as plays that you created on a different computer. 
If so, those plays will be added to your computer’s local play library. 
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The Sync Workflow ​ - Effectively using the Sync feature to view your play library on any computer 
that you use is simple: 

1. When you start FastDraw on your computer, use Sync to download any changes that you 
have saved from any of your other computers. 

2. When you finish working on your new plays, click Sync to save your changes to the cloud. 
These changes can then be downloaded on your other computers in the same manner. 

 
Automated Sync Reminders ​ - By default, FastDraw is automatically set to analyze your local save 
file, and if it detects changes to the file, the program will prompt you to Sync your changes when 
you shutdown the program, and again when you start the program. While we highly recommend 
leaving these automated reminders turned on (as well as completing a Sync each time you are 
prompted), these reminders can be turned off. 
 
Open the File menu from the top menu bar and select Program Settings, and in the next menu 
choose the Sync tab from the top. In this menu you can select to turn off reminders on Shutdown, 
Startup, or both. 
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Getting Started ​ - FastTrade 
 
The FastTrade system allows users to share plays via e-mail. Plays can be sent to other FastDraw 
users, or to other coaches or players who are not FastDraw users. FastDraw users, however, have the 
benefit of being able to add your shared plays directly to their play library. Additionally, they can 
edit those plays once the plays are inside of their FastDraw library.  
 
To share one or more plays, make a check mark next to each play that you would like to share. Then 
find the FastTrade menu at the top, and select Send Plays. 

 
 
In the Send Plays menu that opens, you can specify your recipients by entering their e-mail 
addresses in the “To” section (separated by commas), change the Playbook Name, and include a 
Message to the recipient(s). 
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The recipient(s) of your FastTrade will receive an e-mail containing the play or plays that you shared, 
with your message displayed at the top. 
 

 
 
If you receive a FastTrade from another FastDraw user, the play will be contained in the Inbox of 
your FastTrade Manager, which can be accessed from the FastTrade menu. 
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In the FastTrade Manager, you will see your incoming plays in the Inbox. Place a check mark next to 
your play or plays and select “Add to Library” to add those plays to your play library. 
 

 
 
 
Locating FastTrade Imports ​ - When you add a play or set of plays from your FastTrade Manager 
Inbox, the plays are added to your Play Library, and a Playbook is automatically created that 
contains those play(s). The Playbook is placed in your FastTrade folder in your Playbook Library, and 
the Playbook will open automatically in the Preview tab when you close your FastTrade Manager. 
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To identify the exact location of your plays in your library, click the Playbook tab to view your newly 
created Playbook. In the Playbook Editor window (center window), the plays in the Playbook will be 
listed by Play Name, (# of frames), Team Name, and Series. 
 

 
 
Use these values and the filters in your Draw Library window to locate your plays. 
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ADVANCED​ FASTDRAW OPTIONS 
 
Changing the Court Background - ​When you are working in FastDraw, the default look for your 
diagrams will be with a wood court background. If you would like to switch to a black and white 
diagram with no court background included, click the View menu from the top menu bar, then click 
the option for View Court Background. Follow the same process to turn the wood court background 
back on. 
 

 
 
*Note: To include the wood court background in your printed playbooks, you will need to activate the 
Include Court Background option in the Playbook Settings menu. You must also have the Advanced 
Playbook Settings activated, which is covered on page 26 of the User Guide..* 
 
FastColor ​ - Color can be added to any stencil on the court using the FastColor feature. To add color, 
first click the player or movement stencil that you would like to change, and then click the Color 
icon. 
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In the FastColor menu, select a new or recently used color to add. Click OK to see the color added to 
your selected stencil. 

 

 
 
*Note: If you add FastColor to a player on the court, that color will override any color set for that player 
in the Positions Editor. Any changes made to the default color for the player in the Positions Editor will 
not change the player with FastColor added. 
 
 
Editing Plays ​ - After a play has been created, all of the properties of the play, including the Season, 
Team, Series, and Court Settings, can be edited from the Edit Play menu. To access this menu, 
right-click on the play that you wish to edit and select Edit Court Settings. 
 

 

FastDraw Volleyball User Guide    ​  41 



The Edit Play menu is an exact copy of the New Play menu you see when creating a new play. Here 
you can edit the Play Name, Season, Team, Series, Type, and any of the Court Settings. 
 

 
 

If you want to edit multiple plays at one time to change the Season, Team, or Series, place a 
checkmark next to each play that you wish to edit, and then right-click on any of the selected plays. 
In the right-click menu, you will see options for Change Team To, Change Series To, and Change 
Season To. Use these menus to change the values for all of your checked plays at one time. 
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If you have created a Building Block and would like to convert it to a play, select the Building Blocks 
tab on the left of your Play Library to view your Building Blocks. Place a checkmark next to each play 
that you would like to convert, right-click on any selected play, and then select Convert to Plays. 
 

 
 
Printing Blank Diagrams ​ - To include blank court diagrams in your Playbook, you will need to have 
the Advanced Playbook Settings in FastDraw activated. Activating Advanced Playbook Settings is 
covered on page 26 of the User Guide. 
 
In the Preview tab, click the Playbook Settings icon to open the Playbook Settings menu, and then 
locate the Layout Options section. Check the option for “Print blank diagrams in empty space.” 
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Adding a Team Logo to Playbooks​ - FastDraw allows for the addition of a small team logo in the 
header or footer of any Playbook that you create. You can add a logo in the Program Settings menu 
in FastDraw. In FastDraw, open the File menu from the top menu bar and select Program Settings, 
and then select the Printing tab. In this menu, you are able to set the logo for your team. 
 

 
To set the location of the logo in your playbook, open the Playbook Settings menu in the Preview 
tab. Find the Page Options section of the menu and you will see the option to change the Logo 
location under Header/Footer. From this menu you can also change to a different logo if needed. 
 

 
 

*Note: For the best results, your logo image should be less than 100kb in size.* 
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Playbook, Chapter, and Section Settings ​ - At the top of the Playbook Settings menu, there are tabs 
for Playbook, Chapter, and Sections. Playbook will always be selected by default, and this indicates 
that you are making global changes to the settings of your Playbook. Every change that you make 
will affect each chapter and section in your Playbook. 
 

 
 

By clicking the Chapter or Section tab, you will then be able to select individual chapters or sections 
to edit. Changes made to your selected Chapter or Section will not affect any other Chapters or 
Sections within the Playbook. However, any changes to a specific Chapter will affect all of the 
Sections within that Chapter, unless otherwise edited from the Section tab. 
 

 
 
Frame Layout ​ - The Frame Layout option in the Playbook Settings menu allows you to customize 
the appearance of your plays and notes. The standard setting, Plain, gives you a grid layout of your 
frames with the frame description underneath. 
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Side-by-side places the frames in a column, one on top of the other, with the frame description 
displayed next to the frame. The frame description can be set to the left side or right side of the 
frame, and the frame size can be set to small or large. In side-by-side, only one frame can be used 
per row. 
 

 
Include Table of Contents ​ - To achieve the most professional and organized look for any large 
playbooks that you create, adding a Table of Contents is the quickest and easiest option. A Table of 
Contents can be added from the Cover Pages section of the Playbook Settings menu. 
 

 
 

Each option that you check to activate will add an additional layer of information to the Table of 
Contents. The simple “Include Table of Contents” option will include the page number for each 
Chapter. Additional layers can be added to see the page number for each play or to include 
additional tables at the beginning of each Chapter. 
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Exporting from FastDraw 
 
Saving Playbooks as a PDF file ​ - Any Playbook in FastDraw can be saved as a PDF file, which is the 
best way to share your plays and Playbooks with your players or other coaches who are not using 
FastDraw. 
 
To save a PDF, first create a Playbook containing all of the plays that you wish to be included in the 
PDF file. Use the Playbook Settings menu to format and achieve the look that you want for the 
Playbook, and then click the red PDF icon near the top to create and save your PDF. 
 

 
 
 
 
Copying an image to a Word document or PowerPoint ​ - To copy an image of your play to paste 
into Microsoft Word or PowerPoint, right-click on the diagram and select “Copy Image to Clipboard” 
from the menu. For an individual frame, choose the option for “Copy Image of Selected Frame to 
Clipboard”. To copy the entire play, including all of the frames, select “Copy Image of Play to 
Clipboard”. 
 

 
 

Once your image is copied, paste the image of the frame or play into your Word or PowerPoint 
document. 
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Saving plays as image files ​ - Any playbook in your FastDraw library can be saved as image files, and 
an image will be created for each page contained in your playbook and mirror the exact settings. 
Therefore, you can create an image for each frame of your play, or create an image containing your 
entire play. 
 
The first step is to create a playbook containing any plays that you wish to create image files for. 
Once your playbook has been created, open the Playbook Settings menu to format the playbook. If 
you want every frame of the play to be included in one image, modify your Frames per Row and 
Rows per Page to fit all of your frames on one page. If you want an image of each frame in the play, 
set your Playbook to one Frame per Row and one Row per Page. 
 
Additionally, any headers, footers, page title, play title, or frame descriptions will be included in your 
image if activated. If you simply want an image of the frame with no labels, set your Playbook 
Settings like this: 

 
The resulting image will look like this: 
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Once your Playbook Settings have been set, open the File menu from the top menu bar and select 
Save As Images. In the menu that opens you can set the dimensions for your image, file format, and 
save location. 
 

 
 

 
A folder will be created in the save location that you choose, and the folder will contain an image file 
for each page of your Playbook. 
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Additional ​ FastDraw Resources 
 

For additional help with your FastDraw software, please use the following FastModel Sports 
resources: 
 
 
FastModel Sports Volleyball Help Page ​ - 
https://fastmodelsports.freshdesk.com/support/solutions/9000094857 
 
This URL will take you to the FastModel Sports Volleyball Help page. Use the search box to search 
for the topics you are looking for by keyword ​or browse through the FastDraw User Guide to see all 
of the available FastDraw help topics.​ If you are unable to find the information you are looking for, 
Contact Support by clicking the “New Support Ticket” button and writing into our Support Team 
 
 
FastDraw YouTube Tutorials: ​https://youtu.be/EfpIp3VdMhk 
This URL will take you to our FastDraw Volleyball Tutorial Videos. 
 
 
FastModel Sports on Twitter ​ - ​www.twitter.com/FastModel​ (@FastModel) 
 
Follow FastModel Sports on twitter for the latest help tips and basketball articles, or reach out to us 
from your Twitter account. 
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